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Introduction 
TriLink™ is an Industrial wireless data logger from Fourier Systems, leveraging 
cutting edge wireless data logging for stand alone or field monitoring. TriLink has 
gone one step further from Fourier’s RF wireless range of data loggers by integrating 
Bluetooth wireless technology. TriLink can communicate with all types of current and 
future Bluetooth enabled PocketPCs and PCs. 
The TriLink is ideal for indoor mobility, for instance inside the office or factory floor, 
and outdoor data logging. Data can be turned into graph form, analyzed as well as 
exported to spreadsheets - all in the palm of the hand. Based on existing Fourier 
technologies, the TriLink carries all the same benefits plus more: wireless 
communication, 12-bit resolution and 256 K sample memory.  
The TriLink’s four inputs can connect to 4-20 mA and 0-5 V sensors as well as 
temperature and humidity probes. Using splitter cables you can record data from up 
to 8 sensors simultaneously. The TriLink is capable of recording at rates of up to 
20,800 samples per second, and of collecting up to 170,000 samples in its internal 
memory. 

TriLink is the ultimate multi-platform data logger, allowing both field and stand alone 
operation. TriLink is equipped with a simple keypad and LCD display. TriLink can 
connect via USB cable to a PC or via Bluetooth to a PC or PocketPC with Fourier's 
DaqLab analysis software.  

A rechargeable battery powers the data logger, which automatically switches to 
standby mode 5 minutes after the time of the last data recording, the last button was 
pressed, or the last communication was made with the PC. While on standby, TriLink 
switches to a low-power state whereby the electronic circuitry and the display are 
turned off, using less power. 

The TriLink system also comes with the powerful DaqLab for desktop computers 
software. When the TriLink is connected to a PC, live displays can be viewed at rates 
of up to 100/s, and automatic downloads can be carried out at higher rates. DaqLab 
can display the data in graphs, tables or meters, and can analyze data with various 
mathematical tools. 
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Chapter 1  
TriLink 

1.1.  General 

1.1.1. TriLink: Basic System Contents 

1. The TriLink data logger 
2. Sensors (see your package list) 
3. USB communication cable 
4. DaqLab software installation CD 
5. An AC-DC adaptor 
6. Carrying case 

1.1.2. External Connections 

 

Figure 1: TriLink external connections 

1. Sensor input (In) sockets marked In-1/8, In-2/7, In-3/6 and In-4/5: These 
sockets are used to connect the sensors. Normally, all four sockets can be 
used simultaneously. 
To connect a sensor to the TriLink use one of the sensor cables. Plug the 
stereo plug into the data logger, and the mini-din plug into the sensor - 
arrow facing down. 
In order to connect more than 4 sensors at a time, use the splitter cables, which 
will enable the connection of up to 8 sensors simultaneously. When a splitter 

3. 6 V AC input 
2. USB port 

1. Sensor inputs 
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cable is connected, it must be connected to the socket in the correct numerical 
order (e.g. for 5 sensors, connect the splitter cable to In-4/5). One of the two 
splitter cables is marked with P1 - that is the main input (the lower input number), 
the second line is marked with P2 - indicating that it is the secondary input (the 
higher input number). Connect up to four input splitters (DT225) to split the 
TriLink’s inputs starting with In-4 (the splitters must be connected in order): 
In-4 splits into In-4 and In-5 
In-3 splits into In-3 and In-6 
In-2 splits into In-2 and In-7 
In-1 splits into In-1 and In-8 

2. PC USB communication socket: Connect the mini USB plug of the USB 
communication cable to the TriLink and the USB Type A plug to the computer’s 
USB port.  

3. External DC power supply socket: Plug in an AC/DC 6V adaptor whenever you 
want to save battery power, or to charge the battery when necessary. 
Connecting external power to the TriLink automatically charges the internal 
battery. The adaptor should meet the required specifications (see section 
 1.1.4). 

1.1.3. Battery 

TriLink is equipped with a 2.4 V/750 mAh NiMH rechargeable battery. Before you 
start working with TriLink for the first time, charge the unit for 10 to 12 hours while it 
is turned off. 
The battery lifetime is about 8 hours of continuous work. 
If the data logger’s main battery runs out, the internal 3V Lithium battery backs up 
the memory, so no data will be lost. 
Note: Battery shelf charge life is about 100 hours. To maximize battery shelf charge 
life, always disconnect sensors when not in use. Disconnect TriLink from the 
computer when not in use. You can continue to operate TriLink by plugging it into the 
wall.  

1.1.4. AC/DC Adaptor 

• Output: Capacitor filtered 6 VDC, 300 mA 
• Female plug, center negative 
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1.1.5. Automatic Standby 

TriLink switches automatically to standby mode after 5 minutes have passed since 
the time of the last data recording, the last button was pressed, or the last 
communication was made with the PC. 
While on standby, TriLink switches to a low-power state where the electronic circuitry 
and the display are turned off and TriLink uses less power. 

1.2.  Stand-alone Operation 
Programming TriLink is done via the DaqLab software. TriLink will save the setup 
parameters until the next time you program it. The keypad allows you to begin and 
stop data collection, while the LCD screen displays the recorded values or TriLink's 
status. 

1.2.1. Front Panel Layout 

 
Figure 2: TriLink front panel 

1.2.2. Quick-Start 

Before you first use TriLink, charge the unit for 10 to 12 hours while it is turned off. 

1. Turn on TriLink 

Press the On/Off button. You will see the initialization screen. TriLink performs a 
brief self-check and momentarily displays its version number and battery level, then 
its name and then the display will be changed to show the current status.  

2. Plug in the sensors 

Start with the first input I/O-1 on the left of the logger.  
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Note: Sensors must be added successively, starting with Input 1. If a single sensor is 
used it must be connected to In-1. If two sensors are used, they must be connected 
to In-1 and In-2. 

3. Select setup 

In DaqLab, go to Logger > Setup or click the Setup icon in the tool bar. Select the 
sensor you have connected to Input 1. 
Follow the Setup process to select the sampling rate and sample size for the test you 
need to perform. Click Finish. 

4. Start recording 

Press the Run/Stop button to start recording. 
TriLink will use the stored setup parameters to collect data.  
The LCD screen will display: 
 

Logging 
 

At rates of up to 10 samples per second TriLink displays the recorded data values. 
You can stop recording any time by pressing the Run/Stop button a second time. 
Otherwise logging will stop after the selected number of samples where taken. The 
LCD screen will display the number of the experiment in TriLink’s memory: 
 

_ _ _ LOGGER – RUN _ _ _ 
Log  01 ended 

1.2.3. Internal Clock and Calendar 

The internal clock is set the first time you use the Setup command from the DaqLab 
software to program the TriLink, and is automatically updated to the PC’s time and 
date each time you connect your TriLink to a PC (or PocketPC). 
The internal clock and calendar is kept updated even when the TriLink is turned off, 
but it will be erased if the 2.4 V battery is dead. It will be updated the next time 
TriLink will be connected to a computer. 

1.2.4. Clear the Memory 

TriLink automatically checks the available memory before it begins the recording. If 
there is not enough memory you will see this message on the display: 
 

_ _ _ LOGGER-RUN _ _ _  
Clear = (Run) 

Press the Run/Stop button to clear the memory and begin recording. 
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1.2.5. Choose the Right Setup 

1. Sampling rate 

The sampling rate should be determined by the frequency of the phenomenon being 
sampled. If the phenomenon is periodic, sample at a rate of at least twice the 
expected frequency. For example, sound recordings should be sampled at the 
highest sampling rate – 20,800/sec, but changes in room temperature can be 
measured at slower rates such as once per second or even slower, depending on the 
speed of the expected changes. There is no such thing as over-sampling. For 
extremely smooth graphs, the sampling rate should be about 20 times the expected 
frequency. 
Note: Sampling at a rate slower than the expected rate can cause frequency 
aliasing. In such a case, the graph will show a frequency much lower than expected. 
In Figure 3 below, the higher frequency sine wave was sampled at 1/3 of its 
frequency. Connecting the sampled points yielded a graph with a lower, incorrect 
frequency.  

 

Figure 3: Frequency Aliasing 

2. Sampling points 

After you have chosen the sampling rate, choosing the number of points will 
determine the logging period: Samples / Rate = Logging time. You can also choose 
the duration of an experiment first, and then calculate the number of samples: 
Samples = Logging time × Rate. 

Continuous  
In the Continuous mode, TriLink does not save data, and can continue logging 
indefinitely. 
If TriLink is connected to the PC and the DaqLab software is running, the data is 
automatically transferred to the computer and displayed in a real-time graph. 
To operate in Continuous mode select RATE equal to or less than 100/s and 
SAMPLES = Continuous. 

1.2.6. Programming Rules and Limitations 

The following are some rules and limitations you must take into account when 
programming the TriLink, as TriLink integrates all programming limitations 
automatically. TriLink will only allow the programming of settings that comply with the 
rules below. 

1. Sampling points: 
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• Increasing the number of active inputs limits the number of 
sampling points one can choose. The following condition must 
be always satisfied: Samples × Active Inputs < Memory. 

• TriLink’s memory is sufficient for 170,000 samples. 
• When sampling at rates faster than 100 samples per second the 

memory can store only four experiments of 32,000 samples 
each. 

• When sampling at rates of 100 samples per second or less, 
selecting Maximum sampling points will create up to four 
successive files of 42,000 points each (a total of 170,000 
points), depending on the available memory. 

2. Sampling rate: 

The number of sensors in use limits the maximum sampling rate: 
 

Number of sensors Maximum sampling rate Resolution 
1 sensor 20,800 samples per second 10 bit 
1 sensor 11,200 samples per second 12 bit 
2 sensors 3,400 samples per second 12 bit 
3 sensors 2,500 samples per second 12 bit 
4 sensors 1,900 samples per second 12 bit 
5 sensors 1,600 samples per second 12 bit 
6 sensors 1,400 samples per second 12 bit 
7 sensors 1,200 samples per second 12 bit 
8 sensors 1,050 samples per second 12 bit 

3. Continuous sampling 

• Continuous sampling is possible up to a maximum sampling rate of 
100/s. 
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Chapter 2 Working with Pocket PC 
and DaqLab 

2.1.  Installing the Software 

2.1.1. System Requirements 

To work with DaqLab on your Pocket PC via Bluetooth, ensure your PocketPC is 
running either:  

 Pocket PC 2003  
or 
 Windows Mobile 5 

2.1.2. Installation 

1. Insert the DaqLab CD into your CD drive. 

2. Navigate to the relevant Pocket PC folder located on the CD – 
PocketPC 2003 or Windows Mobile 5 - and double click the Setup 
icon. 

3. Follow the on-screen instructions to install the DaqLab for Pocket PC 
application on your handheld device. 
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2.2.  Overview 

2.2.1. DaqLab for Pocket PC Layout 

The DaqLab for Pocket PC application is designed to support seven major kinds of 
activities: 

• Establishing wireless communication with TriLink 
• Setting up TriLink 
• Collecting and displaying online data  
• Downloading stored data from TriLink 
• Displaying the data in graphs, tables and meters 
• Analyzing the data 
• Exporting data to a desktop computer or the another Pocket PC 

device 
 
Every time you start a new experiment, DaqLab automatically creates a new project 
file. All the information you collect and process for a given experiment is stored in a 
single project file. Each of these files contains all the data sets you collected with the 
TriLink, the analysis functions you’ve processed, and the DaqLab settings for the 
experiment. 
Note: All data sets in a single project must be with the same sampling rate. 

2.2.2. DaqLab for Pocket PC Window Layout 

 

Graph window

Main toolbar

Graph toolbar

 
 

Figure 4: Main DaqLab PocketPC window 
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2.3.  Establishing Wireless Communication 
TriLink uses Bluetooth wireless technology to connect to your Pocket PC. To avoid 
interference between several devices TriLink employs a procedure called pairing1 
that allows any Pocket PC to communicate with only one specific TriLink.  
Every TriLink has a unique name. The pairing process tells the Pocket PC to address 
only a specific name. 
Before you work with TriLink and a Pocket PC you have to perform this pairing 
procedure. DaqLab stores the TriLink's address and will automatically connect to this 
specific TriLink every time you open DaqLab. 
You can always repeat the pairing process if you want to connect to another TriLink. 
 Make sure no USB cable is connected. DaqLab will not establish Bluetooth 

connection while the USB cable is connected even if the pairing process 
was successful. 

1. Pairing your Pocket PC with a TriLink 

1. Turn on TriLink: Push the On/Off button on the TriLink front panel. 

2.  Open the DaqLab application: 

a) Navigate to the Programs folder. 

b) Tap the DaqLab icon.  

3.  Tap Logger on the menu bar, and then tap Comm Setup. 

 

  Figure 5: Bluetooth comm setup dialog 

                                                 
1 Pairing (or bonding) is a concept introduced to create a first time recognition of what devices 
are allowed to communicate with each other or which devices belong together. Devices can 
usually not establish a communication session without a first time pairing. 
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4.  Select the Bluetooth option in the Connection section, and then 
tap Pair TriLink. 

5.  Enter your password (the default password is 1234). 

6.  Tap OK. 

DaqLab searches for Bluetooth devices and displays a list with all the 
devices that were found.  

7.  Tap the name of the TriLink you want to connect to, and then tap 
Pair. 

Note: TriLink briefly displays its name when switched on. 
After pairing is complete DaqLab displays the name of the paired TriLink.  

8. Tap OK. 

You are now ready to begin data logging. 
From now on DaqLab will automatically connect to the paired TriLink. 

2. Renaming TriLink 

1.  Tap Logger on the menu bar, and then tap Comm Setup. 

2.  Select the Bluetooth option in the Connection section, and then 
tap Rename TriLink. 

3.  Enter your password (the default password is 1234). 

4.  Tap OK. 

5.  Enter the new name, then tap OK 

Note: The name can include up to 15 characters. 
 
DaqLab will display the new name. You can always return to the factory name by 
tapping Reset TriLink Name. 

3. Changing the password 

1.  Tap Logger on the menu bar, and then tap Comm Setup. 

2.  Select the Bluetooth option in the Connection section, and then 
tap either Rename TriLink or Pair TriLink. 

3.  Enter the current password (the default password is 1234), and then 
tap Change Password. 

4.  Enter a new password in the New password edit box. 

5.  Confirm the new password in the Confirm password edit box. 

6.  Tap OK. 

 



 
 

18 Chapter 2: Working with Pocket PC and DaqLab 

2.4.  Getting Started 

2.4.1. Set up a Recording Session 

1. Turn on TriLink 

Push the On/Off button on the TriLink front panel. 

2. Connect the sensors you want to use 

See page 8 for external connections. 

3. Open DaqLab application 

1.  Navigate to the Programs folder. 

2.  Tap the DaqLab icon to launch the application.  

 
Figure 6: DaqLab main window 

4. Set up TriLink 

1. Tap Setup  on the main toolbar. 

DaqLab searches for a TriLink device, and then displays the Setup 
dialog: 
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Figure 7: Setup: Selecting sensors 
 

Note: If DaqLab does not find a TriLink, it prompts to a message saying that TriLink 
was not found. Make sure that the TriLink is on. If no TriLink is connected you can 
still work offline and open stored data files.  

2.  Tap the Rate tab and select number of samples per time unit from 
the Rate drop-down menu. 

 
Figure 8: Setup: Selecting sampling rate 

3.  Tap the Samples tab and select the total number of samples from 
the Samples drop-down menu. 
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Figure 9: Setup: Selecting sample size 

4.  Tap OK. 

5. Select display 

Tap a display on the main toolbar: 

Graph , Table  or Meter  
Note: If you begin collecting data from the opening screen DaqLab prompts to Graph 
view. 

6. Start collecting data 

Tap Run  on the main toolbar. 
If the recording rate is 25 measurements per second or less, DaqLab displays the 
data in real-time, plotting it on the graph as it is being recorded. If the recording rate 
is higher than 25/s, the data will be downloaded and displayed automatically, once 
the data recording is finished. 

You can stop recording anytime by tapping Stop  on the main toolbar. 

2.4.2. Download Data 

Whenever data is received from the TriLink, it is accumulated and displayed 
automatically by DaqLab. There are two modes of communication: Online and Post-
session.  
 
Online communication 
When TriLink is connected to the Pocket PC and programmed to run at sampling 
rates of up to 25/s, TriLink transmits each data sample immediately, as it is recorded, 
to the Pocket PC. The software thus displays the data in real-time in both the Graph 
and Table window. 
When TriLink is connected to the Pocket PC and programmed to run at a sampling 
rate of 50/s or higher, data is accumulated in TriLink‘s internal memory. This data is 
not transmitted to the Pocket PC until the recording period has ended, when the data 
is automatically downloaded to the Pocket PC and displayed. 
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Offline data logging 
To download data that was recorded offline, or while TriLink was not connected to a 
Pocket PC device, connect TriLink to the Pocket PC, run DaqLab, tap the menu bar, 
tap Logger, and tap Download. This will initiate the Post-session Data Transfer 
communication mode. Once the transfer is complete, the data will be displayed 
automatically in the Graph window and in the Table window. If there are several 
experiments stored in the TriLink, the first download will bring up the most recent 
experiment; the second download will bring up the first (oldest) experiment, the third 
download will bring up the second experiment, and so on. 
To download a particular experiment, choose Selective download from the Logger 
menu, then select the experiment’s number in the Download dialog box.  

2.4.3. Save Data 

To save your project tap the menu bar, tap Tools on the menu bar, then tap Save 
File. This will save all the data sets under one project file. 
If you made any changes to a previously saved project, tap Save to update the saved 
file or tap Save as to save it under another name. 

2.4.4. Open a File 

1.  Tap Tools on the menu bar, and then tap Open File. 

2.  Tap the file name to open the project. 

DaqLab opens the project and in the Data Map view. Use the Data Map to display 
the desired data set.  

2.4.5. Create a New Project 

There are two ways to create a new project: 

1. Open the DaqLab program, which will open a new file each time. 

2. Tap Tools on the menu bar, and then tap Clear All. 
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2.5.  View the Data 

2.5.1. Display Options 

DaqLab features four views. Three views to display data: Graph view, Table view and 
Meter view. The fourth view, the Data Map enables you to navigate through the 
available data sets. 
To switch to a certain view tap the corresponding tool on the main tool bar: 
 

 – Data Map 

 – Graph view 

 – Table view 

 – Meter view 

2.5.2. Data Map 

The Data Map displays the list of data sets that were recorded or downloaded in the 
current session, as well as the lists of all the processed data sets. 

 
Figure 10: Data Map 

 

To display the complete list of sensors for any individual experiment, tap the plus 
sign (+) next to it. 

To collapse a list under an individual experiment, tap the minus sign (-) next to it. 

To display a certain data set tap its name on the list, then tap Show. 

To hide a data set tap its name on the list, then tap Hide. 

Showing or hiding a data set with the Data Map applies both to the Graph and Table 
views. 
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2.5.3. Graph View 

Tap Graph  to display the graph. The default graph display is the data set or sets 
plotted vs. time, but you can change the X-axis to represent any of the individual data 
sets (see page 61). 

 

Figure 11: Graph view 

The graph usually displays all the data sets of a given recording, but you can use the 
Data Map to remove one or more of the sets from the graph (see page 57). 

In order to keep the graph clear and simple, only one Y-axis is shown on the graph. 
To change the Y-axis, pick the desired sensor from the drop-down list above the axis. 

You can identify the Y-axis by its color, which matches the plot color. 

1. The Cursor 

You can display up to two cursors on the graph simultaneously. 
Use the first cursor to display individual data recording values, to select a curve or to 
reveal the hidden Y-axis. 
Use two cursors to display the difference between two coordinate values or to select 
a range of data points. 
 
To display the first cursor: 

Tap an individual data point on the graph or tap 1st Cursor  on the graph toolbar. 
You can drag the cursor with the stylus onto any other point on the plot, or onto a 

different plot. For finer cursor movements use the forward  and backward  
tools on the graph tool bar.  
The coordinate values of the selected point will appear at the bottom of the graph 
window. 
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To display the second cursor: 

Tap 2nd Cursor  on the graph toolbar 
DaqLab will now display the difference between the two coordinate values. 
 
To remove the cursors: 
Tap 1st Cursor a second time. 
 
To remove the 2nd cursor: 
Tap 2nd Cursor a second time. 

2. Zooming 

1. To zoom into the center of the graph 

1. Tap Zoom in  on the graph toolbar 

2. To reverse the operation, tap Zoom out  on the graph toolbar 

2. To zoom into a specific data point 

1. Select the point with the cursor (see above) 

2. Tap Zoom in  on the graph toolbar 

3. To reverse the operation tap Zoom out  on the graph toolbar. 

3. To zoom into a range 

1. Select the range with both cursors 

2. Tap Zoom in  on the graph toolbar 

3. To reverse the operation tap Zoom out   on the graph toolbar 

4. To zoom into a specific area 

Tap Zoom to selection  on the graph toolbar and drag the stylus diagonally to 
select the area you want to magnify. Remove the stylus to zoom in to the selected 
area. 
Tap Zoom to selection a second time to disable the zoom tool. 

5. Autoscale 

Tap Autoscale  on the graph toolbar to view the full data display. 

6. Manual scaling 

1.  Tap Tools on the menu bar. 

2.  Tap Graph Format, and then tap on the Lines tab. 
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3.  Pick the axis you want to scale from the Select plot drop-down 
menu. 

4.  Uncheck the Autoscale check box and enter the new values in the 
Min and Max edit boxes. 

5.  Tap OK. 

To restore auto scaling tap Autoscale .  

7. The stretch/compress axis tool 

Move the stylus onto one of the graph axes. Drag the stylus to stretch or compress 
the axis scale. Repeat the procedure for the other axis if necessary. 

To restore auto scaling tap Autoscale .  

3.  Scrolling 

After applying the Zoom tool you can scroll the graph while keeping the zoomed 
scale. 

Tap Scroll right  on the graph toolbar in order to scroll the graph to the right. 

Tap Scroll left  on the graph toolbar in order to scroll the graph to the left. 

To restore auto scaling tap Autoscale .  

4.  Selecting what to display on the X-axis 

1.  Tap Tools on the menu bar. 

2.  Tap Graph Format, and then tap on the X Axis tab. 

3.  Pick the data you want to display on the X axis from the X-axis 
drop-down menu. 

4. Tap OK. 

5. Formatting the graph colors 

To change the data line’s color:  

1.  Tap Menu then select Tools. 

2.  Tap Graph Format, and then tap on the Lines tab. 

3.  Pick the plot you want to format from the Select plot drop-down list. 

4.  Tap the color rectangle. 

5. Tap the desired color. 

6. Tap OK. 
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6. Change the graph’s units and its number format 

1.  Tap Tools on the menu bar. 

2.  Tap Graph Format, and then tap on the Units tab. 

3.  Pick the plot you want to format from the Select plot drop-down 
menu. 

 

Figure 12: Selecting units 

4.  Choose the prefix option you want. 

5.  Select the desired number of decimal places. 

6.  To display numbers in scientific format, check the Scientific check 
box. 

7. Tap OK. 

2.5.4. Table Display 

Tap Table  to display the Table view. 
The data that is displayed in the table always matches the data in the graph. Use the 
Data Map to change the displayed data. 

2.5.5. Meter Display 

Tap Meter   to switch to Meter view. 

1. Meter options 

You can use the Meter mode to view data without collecting it or to display data while 
it is being collected. 
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If you switch to Meter mode without running TriLink (i.e. without tapping Run ), 
TriLink continuously takes measurements from all active sensors, DaqLab displays it 

but the data is not stored. A small camera icon  will be displayed on the bottom 
left of the screen. 
You can display one meter at a time. To select what sensor to display pick it from the 
Sensors drop-down menu located above the meter. 
To collect and store data while viewing it in Meter display, simply tap Run. A small 

running man icon  will be displayed on the bottom left of the screen. 

2. Meter types 

There are three meter types: Analog , Digital  and Bar . 
To select a meter type, tap the corresponding icon on the Meter toolbar below the 
meter. 

2.5.6. Preview the Data 

Prior to collecting data you may wish to preview your data. In Preview you can: 
• Ensure that your handheld computer, TriLink and sensors are properly 

connected. 
• Verify that a sensor is measuring what you intended it to measure. 
• Verify that a sensor has reached a stable value. 

In Preview mode data is not saved. 
To preview data: 

1. Setup TriLink as you would normally do. 

2. Tap Logger on the menu bar. 

3. Tap Preview. 

.
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2.6.  Analyzing the Data 

2.6.1. Reading Data Point Coordinates 

Position the cursor on a point to display its coordinates at the bottom of the graph 
window. 

2.6.2. Reading the Difference between Two Coordinate Values 

Position one cursor on the first point and a second cursor on the second point to 
display the difference between the two coordinate values at the bottom of the graph 
window. 

2.6.3. Working with the Analysis Tools 

The analysis tools can only be applied to data sets that are displayed in the graph 
window. 

1.  Use the cursors to select the graph and the data range to which you 
want to apply the analysis.  

2.  Select the analysis function you wish to use. 

The analysis function will be added onto the graph. 
 
To apply an analysis function: 

1.  Tap Tools on the menu bar, and then tap Analysis to display the 
Analysis dialog: 

 

Figure 13: Analysis window 

2.  If you have not selected a plot with the cursor tap the 
desired plot in the Select plot drop-down menu. 

3.  Tap a function in the Function list. 
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4. Tap Apply. 

DaqLab will add the analysis function onto the graph. 

2.6.4. Analysis Tools 

1. Linear fit 

Use Linear Fit to draw a line of linear least square fit  

  baxy +=  

and to display the line’s equation. 

2. Derivative 

Use Derivative to construct a graph in which each point is the slope of the three 
consecutive points on the source graph. 

3. Integral 

Choose Integral construct a graph in which each point is the integral of all the 
preceding points on the source graph. 

4. Statistics 

Use the Statistics tool to display statistics of a selected data set or a range of data. 
The statistics include: 

Average – The average of all the numbers in the range 

StDev. – The standard deviation 

Minimum – The smallest value in the range 

Maximum – The largest value in the range 

Sum – Adds all the numbers in the range 

Area – The area between the graph and the x-axis in the range 

Samples – The number of data points in the range 

Rate – The recording rate 
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2.7.  Exporting the Data 

2.7.1. Export to another Pocket PC by Beaming 

After you have created and saved a data file: 
1.  Position the Pocket PC devices to enable beaming. 

2.  Navigate to the My Document folder and then to the 
DaqLab Data folder. 

3.  Tap and hold the file name you want to beam to display 
a popup menu. 

4.  Tap Beam File…    

5.  Follow the on-screen instructions to complete the 
beaming procedure. 

2.7.2. Export to a Desktop Computer 

To export data from the handheld computer to a desktop computer: 

1.  Connect the Pocket PC to the desktop computer. 

2.  Open the ActiveSync program. 

3.  Click Explore. 

4.  Copy the files you want to your desktop computer. 

5.  Double click a file name to open it with DaqLab for PC software. 
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2.8.  Programming TriLink 

2.8.1. Set up TriLink 

1.  Establish a connection between TriLink and the Pocket PC. 

2. Tap Setup  on the main toolbar. 

3.  Select the sensors you will be using for this session from the 
Sensor input drop-down menu. 

 
4.  Tap the Rate tab and select number of samples per time unit from 

the Rate drop-down menu. 

  

5. Tap the Samples tab and select the total number of samples from 
the Samples drop-down menu. 
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6. Tap OK. 

Note: When you turn off TriLink, it will save the setup for the next session. 

2.8.2. Triggering 

To start the data recording only when a specific time or measurement condition has 
been met: 

1. Establish a connection between TriLink and the Pocket PC. 

2. Tap Setup on the main toolbar. 

3. Tap the Samples tab. 

4. Tap Triggering. 

5.  Pick the triggering sensor from the Based on sensor drop-down 
menu. 

6. Pick one of the following from the Type drop-down menu: 

• None - Trigger is disabled 
• Above level - Start logging only once the measured value is HIGHER than the 

trigger level. 
• Below level - Start logging only once the measured value is LOWER than the 

trigger level. 
Note: The trigger acts on analog measurements only. The trigger condition must be 
fulfilled for at least 300μS. 

• Control Level - The Control Level trigger allows you to create an automatic 
sense and control system. This means that you can connect a sensor 
measuring a certain phenomenon (for example, temperature) and connect a 
device that will start operating when the recorded data from the sensor falls 
above or below a pre-defined threshold (for example, a fan that will start 
operating when the temperature measured by the sensor rises above 30 °C). 
This function requires the use of a splitter cable and a control sensor. The 
cable divides each input into a sensor cable and a controller cable. After 
setting the control level and starting the data logging process, the sensor will 



 
 

 Chapter 2: Working with PocketPC and DaqLab 33 

sample and record the data as usual, but when the measurement from the 
sensor rises above the predetermined threshold value, the controller cable will 
send a pulse of 5V to the control sensor, and will continue to do so until the 
sensor measures a value below the threshold level. When receiving the 5V 
pulse, the control sensor will close/open a relay capable of switching 
110/220V to any load. 

• Time delay - This trigger type enables you to set a timer that will start the 
logging after a predetermined amount of time. After setting the trigger to Timer 
Delay, click the down arrow on the Level combo-box, and select from the 17 
different time options. The timer will start its countdown when you click RUN, 
and the actual recording will start once the countdown has ended. 

7.  Pick the trigger level in the Level drop-down menu. 

8. Tap OK. 

Note: When you turn off TriLink, it will save the setup for the next session. 

2.8.3. Calibrate Sensors 

DaqLab enables you to calibrate any of the linear sensors manually. This two point 
calibration method sets both the gain (slope) and offset (intercept) of the sensor's 
conversion function. The calibration procedure affects DaqLab readings only.  

1. Tap Logger on the menu bar, then tap Calibrate sensors. 

2. Pick a sensor from the Choose sensor drop-down menu. 

3. Tap OK. 

4.  Enter a distinct real value in each of the Real Value edit boxes and 
the corresponding measured values in each of the Measured Value 
edit boxes (The measured values are the values displayed by 
DaqLab when measuring the two real values). 

5. Tap OK. 

The calibrated sensor parameters will be saved in DaqLab. 
To reset to the default calibration for any sensor, repeat steps 1 to 3 above and tap 
Restore defaults. 
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2.9.  Toolbar Buttons 

2.9.1. Main Toolbar 

 Run Begin collecting data 

 Stop Stop collecting data 

 Setup Set up TriLink 

 Data Map Display the Data Map 

 Graph Display the Graph 

 Table Display the Table 

 Meter Display a Meter 

2.9.2. Graph Toolbar 

 Zoom in Zoom in around a selected point or in to a 
selected range 

 Zoom out Reverse the most recent zoom operation 

 
Zoom to 
selection Zoom in to a selected area 

 Auto scale Display all the data 

 1st Cursor Display or remove the first cursor 

 2nd Cursor Display or remove the second cursor 

 Move right Move the cursor one point to the right 

 Move left Move the cursor one point to the left 

 Scroll right Scroll the graph one page to the right 

 Scroll left Scroll the graph one page to the left 

2.9.3. Meter Toolbar 

 Analog Display an analog meter 

 Bar Display a bar meter 

 Digital Display a digital meter 
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Chapter 3 Working with a Desktop 
Computer and DaqLab 

3.1. Installing the Software 

3.1.1. System Requirements 

To work with DaqLab, your system should be equipped with the following: 
 
Windows 
Software 

 Windows 98, 2000, XP and Vista 
 Internet Explorer 5.0 or later  
 Bluetooth wireless technology (Widcom or Toshiba chipsets) 

Hardware 
 Pentium II 600MHz or higher (Pentium 4, 1.6GHz or higher is needed 

for video motion analysis recordings) 
 32 MB RAM (64 MB recommended) 
 10 MB available disk space for the DaqLab application (50 MB to 

install the supporting applications) 
 Free USB port (if not connecting via Bluetooth) 

3.1.2. Installation 

1.  Close all programs 

2.  Insert the CD labeled DaqLab into your CD-ROM drive 

Installation will begin automatically. Simply follow the on-screen instructions to 
continue. 
If auto run is not working, open My Computer and click on the CD drive folder (d: 
drive in most cases) and double-click on the setup icon, then follow the on-screen 
instructions. 
To uninstall the software: From the Start menu select Settings and click on 
Control Panel, then use the Add/Remove Programs feature to remove the DaqLab 
application. 
When updating the software, always remove the old version before starting a new 
installation. 
 
To install the USB driver on WinXP: 

1. Connect your data logger to a USB port on your PC and turn the data 
logger on. Windows will automatically detect the new device and open 
the Found New Hardware Wizard. 
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2. Select the No, not this time to prevent Windows from searching for 
software on the Internet, then click Next. 

3. Insert the DaqLab installation CD into your CD drive. Windows will 
automatically detect and copy the necessary files to your system. 

4. Click Finish. Windows will open the Found New Hardware Wizard for 
the second time. 

5. Click Next to complete the installation. Windows will automatically install 
the necessary components on your system. 

6. Click Finish. 

Note to the Windows XP user:  
If the Found New Hardware wizard prompts you to the following Hardware 
Installation dialog box, click Continue Anyway to proceed. 
: 
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3.2.  Overview 

3.2.1. DaqLab On-screen Layout 

DaqLab is a comprehensive program that provides you with everything you need in 
order to collect data from the TriLink, display the data in graphs, meters and tables, 
and analyze it with sophisticated analysis tools. 
DaqLab connects to TriLink either with USB cable or with Bluetooth wireless 
communication technology. 
The program includes three main windows: Graph window, Table window, and a 
navigation window called the Data Map. You can display all three windows 
simultaneously or any combination of the three.  
The most commonly used tools and commands are displayed on three toolbars. 
Tools that relate to all aspects of the program and tools that control the TriLink are 
located in the main (upper) toolbar. Tools specific to the graphs are located on the 
graph toolbar and tools specific to the tables are located on the table toolbar. 

3.2.2. DaqLab Window Layout 

Data map

Graph window

Information bar

Table window

Main toolbar

Graph toolbar
 

Figure 14: DaqLab window layout 

3.2.3. Working with Projects 

Every time you start a new session, DaqLab automatically creates a new project file. 
All the information you collect and process for a given session is stored in a single 
project file. Each of these files contains all the data sets you collected with the 
TriLink, the analysis functions you’ve processed, specific graphs and the tables 
you’ve created. 
Note: All data sets in a single project must be with the same sampling  rate. 
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3.3.  Establishing Communication 
TriLink uses either Bluetooth wireless technology or USB cable connection to 
connect to your computer. To use Bluetooth technology your computer must be 
equipped with Bluetooth capabilities. 
DaqLab supports Bluetooth chipsets from Toshiba and Broadcom/Widcom. 
 
To avoid interference between several devices TriLink employs a procedure called 
pairing 2 that allows any computer to communicate with only one specific TriLink.  
Every TriLink has a unique name. The pairing process tells the computer to address 
only a specific name. 
Before you work with TriLink and a computer you have to perform this pairing 
procedure. DaqLab stores the TriLink's address and will automatically connect to this 
specific TriLink every time you open DaqLab. 
You can always repeat the pairing process if you want to connect to another TriLink. 
 Make sure no USB cable is connected. DaqLab will not establish Bluetooth 

connection while the USB cable is connected even if the pairing process 
was successful. 

3.3.1. Connecting your Computer with a TriLink via USB 

1.  Connect the mini USB plug of the USB communication cable to the 
USB input at the bottom of TriLink.  

2.  Connect the USB plug of the USB communication cable to a free 
USB input at the back of your computer. 

3. Turn on the TriLink. Push the On/Off button on the TriLink front 
panel. 

4.  Open the DaqLab application. Click the DaqLab icon on the PC 
desktop. 

5.  Go to Logger > Com Setup on the main menu. Select Serial 
communication. 

                                                 
2 Pairing (or bonding) is a concept introduced to create a first time recognition of what devices 
are allowed to communicate with each other or which devices belong together. Devices can 
usually not establish a communication session without a first time pairing. 
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Figure 15: Com setup window 

6. Click Try to connect. The DaqLab will establish communication with 
the TriLink. 

3.3.2. Pairing your Computer with a TriLink via Bluetooth 

1.  Turn on the TriLink. Push the On/Off button on the TriLink front 
panel. 

2.  Open the DaqLab application. Click the DaqLab icon on the PC 
desktop. 

3.  Go to Logger > Com Setup on the main menu. Select Bluetooth 
communication. 

  

4.  Go to Logger > Bluetooth Setup on the main menu. 

 

Figure 16: Bluetooth setup  
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5.  Click Pair TriLink. 

DaqLab searches for Bluetooth devices and displays a list with all the 
devices that were found.  

 

Figure 17: Searching for TriLink 

6. Click the name of the TriLink you want to connect to, and then click 
Pair. 

Note: TriLink briefly displays its name when switched on. 
 
After pairing is complete DaqLab displays the name of the paired TriLink.  

7. Click OK 

You are now ready to begin data logging. 
From now on DaqLab will automatically connect to the paired TriLink. 

3.3.3. Renaming TriLink 

1. Go to Logger > Bluetooth Setup on the main menu. 

2. Click Rename TriLink. 

 

Figure 18: Renaming TriLink 
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3. Enter the new name, and then click OK. 

Note: The name can include up to 15 characters. 
 
DaqLab will display the new name. You can always return to the factory name by 
clicking Reset TriLink Name. 

3.4.  Getting Started 

3.4.1. Set up a Recording Session 

1. Prepare TriLink 

1.  Turn on TriLink. 

2.  Open the DaqLab software. 

3.  Connect TriLink to the PC via USB or Bluetooth communication (as 
explained in previous section). 

4.  Plug in any external sensors. 

2. Setup the TriLink 

1. Click Setup Wizard  on the main toolbar. 

2. Follow the instructions in the Setup Wizard (see page 99). 

3. Start Recording 

Click Run  on the toolbar to start recording. 
If the recording rate is 100 measurements per second or less, DaqLab automatically 
opens a graph window displaying the data in real-time, plotting it on the graph as it is 
being recorded. If the recording rate is higher than 100/s, the data will be 
downloaded and displayed automatically, once the data recording is finished. 
If you are recording at a rate of 500/s or 1,000/s, DaqLab displays an online preview 
at a rate of 25/s. 

You can stop recording anytime by clicking Stop  on the toolbar. 

3.4.2. Data Recording Options 

To set the behavior of the data display when you start a new recording session, click 

on the down arrow next to the Run button , and select one of the following: 
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1. Single measurement 

DaqLab will open a new project file every time you start a new recording session. 

2. Replace 

DaqLab will display the new data set in place of the old one. The project’s old data 
sets will still be available in the same project file. They will be listed in the Data Map 
and you can add them to the display at any time. 

3. Add 

DaqLab will add the new data set to the graph in addition to the old ones. 

Note: A maximum of 8 data sets can be displayed on the graph at the 
same time. 

3.4.3. Download Data 

Whenever data is received from the TriLink, it is accumulated and displayed 
automatically by DaqLab. There are two modes of communication: Online and Post-
session.  
 
Online communication 
When TriLink is connected to the PC and programmed to run at sampling rates of up 
to 100/s, TriLink transmits each data sample immediately, as it is recorded, to the 
PC. The software thus displays the data in real-time in both the graph window and 
the table window. 
When TriLink is connected to the PC and programmed to run at a sampling rate of 
500/s or 1000/s, TriLink transmits every twentieth or fortieth data sample online. This 
means DaqLab displays data at a rate of 25/s, while the full data is accumulated in 
TriLink‘s internal memory. Once the recording has ended, the full data is 
automatically downloaded to the PC and displayed. 
When TriLink is connected to the PC and programmed to run at a sampling rate of 
11,200/s or 20,800/s, data is accumulated in TriLink‘s internal memory. This data is 
not transmitted to the PC until the recording period has ended, when the data is 
automatically downloaded to the PC and displayed. 
 
Offline data logging 
To download data that was recorded offline, or while TriLink was not connected to a 
PC, connect TriLink to the computer, run the DaqLab program and click Download 

 on the toolbar. This will initiate the Post-session Data Transfer communication 
mode. Once the transfer is complete, the data will be displayed automatically in the 
graph window and in the table window. If there are several experiments stored in the 
TriLink, the first download will bring up the most recent experiment; the second 
download will bring up the earliest file, the third download will bring up the second 
earliest file, and so on. 
To download a particular experiment, choose Selective download from the Logger 
menu, then select the experiment’s number in the Download dialog box.  
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Click Cancel in the Download progress window at any time to stop downloading the 
data. 

3.4.4. Save Data 

Click Save  on the main toolbar to save your project. This will save all the data 
sets, graphs, and tables under one project file. 
Saving the project will also save any special formatting and scaling you did. 
 If you made any changes to a previously saved project, click Save to update the 
saved file or select Save as… from the file menu to save it under another name. 

Note: 

To delete a specific data set, a graph or a table from the project, use the 
Data Map.  

To remove unwanted data from a specific data set, apply the Crop tool.  

3.4.5. Open a File 

1.  Click Open  on the main toolbar 

2.  Navigate to the folder in which the project is stored 

3.  Double click the file name to open the project 

DaqLab opens the project and displays the first graph on the graph list. If the project 
does not include saved graphs, the file opens with an empty graph window. Use the 
Data Map (see page 96) to display the desired data set.  

3.4.6. Create a New Project 

There are three ways to create a new project: 

1.  Open the DaqLab program, which will open a new file each time 

2.  When working in Single Measurement mode, a new project is 
opened every time you click on the Run button to start a new 
recording. 

3.  Any time you click New button  on the toolbar. 

3.4.7. Import Data 

Any file that is in comma separated values text format (CSV) can be imported into 
DaqLab. 
To import a CSV file: 

1.  Click File on the menu bar, then click Import CSV file 

2.  In the dialog that opens, next to Look in, navigate to the drive and 
folder that contains the CSV file 

3.  Select the file 
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4.  Click Open 

Tips: 
To create a text file in a spreadsheet: 

1.  Open a new spreadsheet 

2.  Enter your data according to the following rules: 

a) The first row should contain headers. Each header 
includes the name of the data set and units in 
brackets e.g. Voltage (V).  

b) The first column should be the time. The time interval 
between successive rows must match the time 
intervals accepted by DaqLab. You can export 
DaqLab files to Excel to learn about these time 
formats.  

See for example the table below: 

 

3.  On the File menu, click Save As. 

4.  In the File name box, type a name for the workbook. 

5.  In the Save as type list, click the CSV format.  

6. Click Save.  

To import files that were previously exported from DaqLab, open DaqLab and import 
the file as described above as they are already in CSV format. 

3.4.8. Date Format Settings 

To set the way data will be displayed on screen, go to File > Date format settings to 
open the Date format settings dialog: 

 

Figure 19: Date format settings dialog box 
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Click the desired option, and then click OK. 

3.4.9. Print 

1. Print a graph 

1.  Click Print  on the main toolbar. 

2.  Select the Graph 1 option (when in split graph mode you can 
choose between Graph 1 and Graph 2). 

3.  Click Print to open the print dialog box. 

4.  Click OK. 

DaqLab will print exactly what you see in the graph display. 

2. Print a table 

1.  Click Print  on the main toolbar. 

2.  Select the Table option. 

3.  If you want to print only a specific range, uncheck the Print all data 
check box and type the desired row numbers into the To and From 
edit boxes. 

4.  Click Print to open the print dialog box. 

5.  Click OK. 
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3.5.  Viewing the Data 

3.5.1. Display Options 

The DaqLab program’s screen consists of three parts: the Graph window, Table 
window and Data Map. You can display all three parts simultaneously (the default 
view) or any combination of the three. 
The graph window is the main window by default and is and displayed in the center 
of the application window.  
In addition to these sections, you have the option to display an on-screen meter for 
each of the sensors. 

3.5.2. Graph Display 

Click Graph  to display or hide the graph. The default graph display is the data 
set or sets plotted vs. time, but you can change the X-axis to represent any of the 
individual data sets (refer to page Error! Bookmark not defined.). 
The graph usually displays all the data sets of a given recording, but you can use the 
Data Map to remove one or more of the sets from the graph (refer to page Error! 
Bookmark not defined.). 
In order to keep the graph clear and simple, only two Y-axes are shown on the graph 
at once. If there are three curves in the graph, one of the Y-axes is hidden. In order 
to make this axis visible, select the corresponding plot with the cursor (refer to bullet 
  2 below). 
You can identify the Y-axis by its color, which matches the plot color. 

1. Split graph view 

DaqLab enables you to display your data in two separate graphs within the graph 
window. 

1. Click Split graph  on the graph toolbar to split the graph 
window into two separate graphs. 

2. Click Edit graph  on the graph toolbar to open the Edit graph 
dialog box. 

3. Choose which data sets to display on each of the graphs (or use 
the Data Map to do so – refer to page Error! Bookmark not 
defined.). 

4. To return to the single graph display, click Split graph  a second 
time. 

2. The cursor 

You can display up to two cursors on the graph simultaneously. 
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Use the first cursor to display individual data recording values, to select a curve or to 
reveal the hidden Y-axis. 
Use two cursors to display the difference between two coordinate values, to display 
the frequency of periodic data or to select a range of data points. 
 
To display the first cursor: 

Double click on an individual data point or click Cursor  on the graph toolbar. 
You can drag the cursor with the mouse onto any other point on the plot, or onto a 
different plot. For finer cursor movements use the forward and backward keys on the 
keyboard.  
The coordinate values of the selected point will appear in the information bar at the 
bottom of the graph window. 
 
To display the second cursor: 

Double click again anywhere on the graph area or click 2nd Cursor . 
The information bar will now display the difference between the two coordinate 
values. 
 
To remove the cursors: 
Double click anywhere on the graph area, or click 1st Cursor a second time. 
 
To remove the 2nd cursor: 
 
Click 2nd Cursor a second time. 
 
To display the cursors in split graph mode: 
To display the cursors on the upper graph, use the same method as for single graph 
mode. 
To display the cursors on the lower graph, you must first remove them from the upper 
graph and then double click anywhere on the lower graph to display the first cursor. 
Double click a second time to display the second cursor, and double click a third time 
to remove the cursors. 

3. Zooming 

To zoom in to the center of the graph 

1. Click Zoom in  on the graph toolbar 

2. To reverse the operation, click Zoom out  on the graph toolbar 

To zoom in to a specific data point 

1.   Select the point with the cursor (see above) 

2. Click Zoom in  on the graph toolbar 
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3. To reverse the operation click Zoom out  on the graph toolbar 

To zoom in to a range 

1.  Select the range with both cursors 

2.  Click Zoom in  on the graph toolbar 

3. To reverse the operation click Zoom out  on the graph toolbar 

To zoom in to a specific area 

1.  Click Zoom to selection  on the graph toolbar and drag the 
cursor diagonally to select the area you want to magnify. Release 
the mouse button to zoom in to the selected area. 

2.  Click Zoom to selection a second time to disable the zoom tool. 

Autoscale 

Click Auto scale  on the graph toolbar to view the full data display, or 
double click on an axis to auto scale that axis alone. 

Manual scaling 

1.  Click Graph properties  on the graph toolbar to open the 
Graph properties dialog. 

2.  Select the Scale tab, and choose the axis you want to scale in the 
Select axis drop-down menu. 

3.  Uncheck the Autoscale check box and enter the new values in the 
text box. 

4.  Click OK. 

5.  To manually scale a specific axis, right click on the axis to open its 
Properties dialog. 

6.  To restore auto scaling click Autoscale .  

The stretch/compress axis tool 

1.  Move the cursor onto one of the graph axes. The cursor icon 
changes to the double arrow symbol (↔), indicating that you can 
stretch or compress the axis scale. Drag the cursor to the desired 
location. Repeat the procedure for the other axis if necessary. 

2.  Double click on the axis to restore auto scaling. 

4. Panning 

1. Use the pan tool after zooming in to see any part of the graph that 
is outside the zoomed area. 
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2. To do this, click Pan  on the graph toolbar, then click anywhere 
on the graph and drag the mouse to view another area. 

3. Click Pan a second time to disable the Pan tool. 

5. Edit the graph 

1. Use the Edit graph dialog box to select which data sets to display 
on the graph’s Y-axis and to change the X-axis from time, to one of 
the data sets. 

2. Click Edit graph  on the graph toolbar to open the Edit graph 
dialog box: 

 

Figure 20: Edit graph dialog box 

3. To select a data set to display on the Y-axis, click on the data set’s 
name in the Y-axis list. To display more than one curve, click on the 
data sets you want. 

4. A list entry that begins with a TriLink comment denotes a recorded 
data set.  A list entry that begins with an input number denotes the 
next recording and will be displayed on the graph the next time you 
start a recording. 

5. To deselect a data set click on it a second time. 

6. To select a data set for display on the X-axis, click on the data set’s 
name in the X-axis list. You can only select one data set at a time 
for the X-axis. 

7. Click OK. 

6. Format the graph 

You can change the data line’s color, style and width. You can also add markers that 
represent the data points on the graph and format their style and color. 
The color of the Y-axis matches the corresponding plot’s color and will automatically 
change with any change made to the color of the corresponding plot.  
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1. Click Graph properties  on the graph toolbar to open the 
Graph properties dialog box. 

2. Select the Lines tab, and then select the plot or axis you want to 
format in the Select plot drop-down menu. 

3. From here you can format the line’s color, style and width, as well 
as the markers’ color and style. To remove the line or the marker, 
uncheck the corresponding Visible check box. 

4. Click OK. 

5. To restore the default formatting, click Restore default. 

7. Change the graph’s units and its number format 

1. Click Graph properties  on the graph toolbar to open the 
Graph properties dialog box. 

2. Select the Units tab, and then select the plot or axis you want to 
format in the Select plot drop-down menu. 

3. Choose the prefix option. 

4. Select the desired number of decimal places. 

5. To display numbers in scientific format, check the Scientific check 
box. 

6. Click OK. 

8. Add a graph to the project 

DaqLab displays new data in the graph window every time you start a new recording. 
You can always display previous data using the Edit graph dialog or by double-
clicking on the data’s icon in the Data Map. If you want to save a graph that you 
created to your project, or to update a saved graph with changes you made, use the 
Add to project tool: 

Click Add to project  on the graph toolbar. 

3.5.3. The Table Display 

Click Table  to display or to remove the table window. 

The data in the table always matches the data that is currently displayed on the 
graph. 

When you start a new recording, DaqLab displays the new data in the table as well 
as on the graph. 
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1. Formatting the table 

Changing column width 
Drag the boundary on the right side of the column heading until the column is the 
desired width. 

Changing row height 
Drag the boundary below the row heading until the row is the desired height. 

Formatting the fonts 

1. Click Table on the menu bar, and then click Properties. 

2. Select the Font tab. 

3. Format the font, as well as the font’s style and size. 

4. Click OK. 

Changing units and number format 

1.  Click Table on the menu bar, and then click Properties. 

2.  Select the Units tab, and then select the plot you want to format 
from the Select plot drop-down menu.  

3.  Choose the prefix option. 

4.  Select the desired number of decimal places. 

5.  To display numbers in scientific format, check the Scientific check 
box. 

6.  Click OK. 

3.5.4. Meters 

DaqLab enables you to view data in meters format on the screen (one meter for each 
sensor), with up to four meters showing at once. The meters can display live data 
while DaqLab is recording, or saved data when a saved file is replayed. 
When a cursor is displayed, the meter shows the measured values that correspond 
to the time of the point at which the cursor is positioned. 
There are three meter types: Analog, bar and digital.  
The meter’s scaling automatically matches the graph’s scaling. 
To set up the meters: 

1. Click Meter Setup  on the main toolbar. 

2. Select the meter type, and the data set to be displayed. 

3. A list entry that begins with a graph number denotes a displayed 
data set. A list entry that begins with an input number denotes the 
next recording, and will be displayed on the meter the next time you 
start a recording 

4. Repeat this procedure for up to four meters. 
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5. To remove the meters click Meter Setup , and click Remove 
all. 

3.5.5. Data Map 

Click Data Map  to display or remove the Data Map. 
The data map is a separate window that displays the list of data sets that were 
recorded or downloaded in the current session, as well as the lists of all the saved 
graphs. Use the Data Map to navigate through the available data sets and to keep 
track of the data that is being displayed in the graph window. 
Note: The data in the table always matches the data that is currently displayed on 
the graph. 

1. Control the display with the Data Map 

The items in the Data Map are sorted into two main categories: 
• Data sets (including analysis functions) 
• Saved graphs 

Double click on a category to bring up the full list. Double click a second time to 
collapse the list. You can also use the plus (+) and minus (-) signs next to the icons 
to expand or collapse the categories. 
The Data sets' list expands to sub-categories of recorded data and functions. To 
display the complete list of measurements, or the complete list of analysis functions 
performed on the measurements for any individual data capture, double click the 
file’s icon or click the plus sign (+) next to it. 
To collapse a list under an individual data capture, double click the corresponding 
icon or click the minus sign (-) next to it. 
To display a data set or a saved graph double click its icon. Double click a second 
time to remove it. 
You can also use a shortcut menu to display or remove a data set from the graph. 
Simply right-click an icon, then click Display on graph #1 or Display on graph #2. 
To delete an individual item from the Data Map and from the project, right-click on its 

icon and click Delete. To permanently delete the item, click Save  on the main 
toolbar. 

To remove all data sets from the Data Map, right-click the Data sets icon  and click 
Clear All Data. 

2. Understanding Data Map icons 

 Data sets list 
  Functions – Includes all the analysis functions of the project 
   Individual function – Currently not on display 
   Individual function – Currently displayed on graph 1 
   Individual function – Currently displayed on graph 2 
   Individual function – Currently displayed both on graphs 1 and 2 
   Function 
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  Data capture – Includes all recorded data of the recording 
   Individual data set – Currently not on display 
   Individual data set – Currently displayed on graph 1 
   Individual data set – Currently displayed on graph 2 
   Individual data set – Currently displayed both on graphs 1 and 2 
   Raw data 

 List of saved graphs 
  Saved graph – Data sets vs. time 
  Saved graph – Data sets vs. data set 
   Graph currently not on display 
   Graph currently displayed on graph 1 
   Graph currently displayed on graph 2 
   Graph currently displayed both on graphs 1 and 2 

3.5.6. Exporting Data to Excel 

 

Click Export to Excel  on the graph toolbar, or go to Graph > Export to Excel, 
to export the data that is currently displayed on the graph to Excel. DaqLab will then 
open a new Excel workbook displaying the data as well as the TriLink comment, 
serial number and the alarm level setup. Data that exceeds any of the alarm levels 
will be highlighted by arrows. 

1. Export all open data sets 

You can easily export all open data sets in the Data Map to the same Excel file, at 
once, rather than individually as in previous versions of DaqLab. Each data set will 
be exported to a separate worksheet. 
Go to File > Export project to Excel.  

2. Exporting over 64,000 samples to Excel 

Each worksheet in the Excel application allows up to 64,000 rows of data to be 
imported. If your data set contains over 64,000 sampling points, then additional 
worksheets will be created when exporting this data to Excel. For instance, if you 
have a data set containing 100,000 points then Excel will create two worksheets, one 
containing the maximum 64,000 points and the second containing the remaining 
36,000 points. 

3. Export file settings 

If DaqLab fails to export the data properly, try to change the export file settings: 

1. Click File on the menu bar, and then click Export file settings. 

2. Check the Ignore regional settings check box and click OK. 
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3.5.7. Copying the Graph as a Picture 

You can copy the graph to the clipboard as a picture and then paste it to other 
Windows programs such as Word or PowerPoint: 

1. In the Graph menu, click Copy graph. 

2. Open the destination file. 

3. In the destination file, right click and select Paste. 
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3.6.  Programming TriLink 

3.6.1. Setup 

1. Quick setup 

Use the Setup wizard to guide you through the setup process. 

1.  Click Setup wizard  on the main toolbar to open the Setup 
wizard: 

 

Figure 21: Setup wizard: Step 1 of 3 

The first step is to assign sensors to each input. You can manually 
select the sensors you are using from the corresponding input drop-
down menus. 

2.  Click Next to move to the second step: 
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Figure 22: Setup wizard: Step 2 of 3 

3.  Select the desired recording rate in the Select rate drop-down 
menu.  

4.  Select the Scroll option if you want the graph window to scroll as 
the data recording progresses. 

5.  Select the desired data recording mode in the Select recording 
mode drop-down menu. 

6.  Click Next to move to the third step: 

 

Figure 23: Setup wizard: Step 3 of 3 

7.  Select the desired length of the recording period in the Select 
recording time drop-down menu.  
The recording period is displayed as a unit of time by default. To 
display the recording period as the number of recording samples, 
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select the By samples option. The number of samples is calculated 
with the following formula: 

 Total recording samples Recording periodRecording rate= ×  
8.  To start the data recording only when a specific time or 

measurement condition has been met click Triggering to open the 
Triggering dialog box (see page 102) 

9.  Click Finish to complete the setup and to send the setup command 
to the TriLink. 

2. Define sensor properties 

Some of the sensors can display their data in different units. For example, the 
Temperature sensor can display in C or F.  
You can define the properties of each sensor individually in the first step of the Setup 
wizard. 

1.  Click Setup wizard on the main toolbar to open the Setup wizard. 

2.  Click Properties  next to the input you want to set. 

3.  Click the check boxes next to the desired measurements. 

4.  To change more properties, click the tab at the top of the dialog box. 

5.  Click OK. 

3. Presetting the display 

You may want to define the graph’s settings, such as formatting and scaling the 
graph and selecting the axes, and to define the meters’ settings prior to beginning a 
recording session. You can define the settings of each sensor input individually in the 
first step of the Setup wizard: 

1.  Click Setup Wizard on the main toolbar to open the setup wizard 

2.  Click Properties  next to the input you want to set. 

3.  Click the Display properties tab. 



 
 

58 Chapter 3: Working with a Desktop Computer and DaqLab 

 
Figure 24: Display property dialog box 

4. Select a measurement from the Select view drop-down menu. 

5.  Select the graph or graphs in which you would like to display the 
data, from the Display on graph drop-down menu. 

6.  Select a meter in the Meter type drop list if you want to display the 
data in a meter as well as on the graph. 

7.  Format the line and markers in the Plot section. 

8.  If you want a specific scale, uncheck the Autoscale check box and 
enter the desired minimum and maximum values of the axis. 

9.  Click OK. 

4. Preset the graph’s X-axis 

1.  Click X-Axis display properties in the first step of the Setup wizard 
to open the dialog box: 
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Figure 25: X-axis properties dialog box 

2.  Select the graph you wish to modify. 

3.  Select the measurement you’d like to display in the X-axis. 

4.  If you want a specific scale, uncheck the Auto scale check box and 
enter the minimum and maximum values of the axis. 

5.  Click OK. 

5. Triggering 

To start the data recording only when a specific time or measurement condition has 
been met, click Triggering in step 3 of the Setup wizard to open the triggering dialog 
box: 

 

Figure 26:Triggering dialog box 

Choose one of the following from the Type options: 

• None - Trigger is disabled 
• Above level - Start logging only once the measured value is 

Higher than the trigger level. 
• Below level - Start logging only once the measured value is 

LOWER than the trigger level. 
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• Event Recording - This function enables you to record the 
exact time and date at which a certain phenomenon occurred: 
The trigger level set for this option is actually a threshold setting. 
Each time the threshold is crossed, TriLink will record the exact 
time and date of the occurrence, and will continue to do so until 
the desired number of samples has been obtained. 

Note: The trigger acts on analog measurements only. The trigger condition must be 
fulfilled for at least 300μS. 

• Control Level - The Control Level trigger allows you to create 
an automatic sense and control system. This means that you 
can connect a sensor measuring a certain phenomenon (for 
example, temperature) and connect a device that will start 
operating when the recorded data from the sensor falls above or 
below a pre-defined threshold (for example, a fan that will start 
operating when the temperature measured by the sensor rises 
above 30 °C). This function requires the use of a splitter cable 
and a control sensor. The cable divides each input into a sensor 
cable and a controller cable. After setting the control level and 
starting the data logging process, the sensor will sample and 
record the data as usual, but when the measurement from the 
sensor rises above the predetermined threshold value, the 
controller cable will send a pulse of 5V to the control sensor, and 
will continue to do so until the sensor measures a value below 
the threshold level. When receiving the 5V pulse, the control 
sensor will close/open a relay capable of switching 110/220V to 
any load. 

• Time delay - This trigger type enables you to set a timer that will 
start the logging after a predetermined amount of time. After 
setting the trigger to Timer Delay, click the down arrow on the 
Level combo-box, and select from the 17 different time options. 
The timer will start its countdown when you click RUN, and the 
actual recording will start once the countdown has ended. 

1.  Select the trigger level in the Level drop list 

2. Click OK 

Note: When you turn off TriLink, it will save the setup for the next session. 

3.6.2. Start Recording 

Click Run  on the main toolbar. Click the down arrow to change the 
recording mode. 

3.6.3. Stop Recording 

Click Stop  on the main toolbar 
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3.6.4. Clear TriLink’s Memory 

To erase all recorded data currently stored in the TriLink, click Clear memory in the 
Logger menu (TriLink must first be connected to the PC). 

3.6.5. Adding a Comment to TriLink 

You can add a comment to each TriLink. The comment will serve as a name to 
identify the specific TriLink in addition to its serial number. Every time data is being 
downloaded from a TriLink, its comment and the serial number will be displayed in 
the graph title and on the corresponding icon in the Data Map.  
The comment and the serial number will also be displayed in prints and exported 
files.  
The comment can include up to 20 characters. 
 
To add a comment: 

1.  Connect TriLink to the PC.  

2.  Click Logger on the main menu, and then click Set comment. 

3.  Click the Comment text box and type a comment (e.g. its location). 

4.  Click OK. 

3.6.6. Calibrating the Sensors 

DaqLab enables you to calibrate any of the linear sensors manually. This two point 
calibration method sets both the gain (slope) and offset (intercept) of the sensor's 
conversion function. The calibration procedure affects DaqLab readings only. 

1.  Select the Calibrate sensors option from the Logger menu. 

2.  You will be prompted to enter a password to access the Calibration 
feature. Enter the default DaqLab password: 1234.  

It is recommended to change this password to protect your 
calibrated sensor values from unauthorized calibrations by other 
users. 

 
Figure 27: Calibration password dialog 

3.  Choose a sensor from the Select sensor drop list and click OK. 

4.  Click the Calibration tab. 
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5.  Enter a distinct real value in each of the Real Value edit boxes and 
the corresponding measured values in each of the Measured Value 
edit boxes (The measured values are the values displayed by 
DaqLab when measuring the two real values). 

6.  Click OK. 

The calibrated sensor parameters will be saved in DaqLab. 
To reset to the default calibration for any sensor, select the sensor and click Restore 
defaults. 

3.6.7. Define a Custom Sensor 

DaqLab enables the user to define additional custom sensors. This is a useful tool for 
when TriLink is communicating with many sensors from different vendors for 
example.  
Any additional sensor that you would like to connect to TriLink must comply with the 
following restrictions: 
1) The sensor’s output must be greater than or equal to 0V or 0 mA and less than 

or equal to 5V or 20 mA. Remember that all sensors transform actual data into 
electrical data, so the electrical output should remain between 0 and 5 volts or 
0 and 20 mA. 

2) The sensor Transfer Function (sensor output voltage changes vs. the sampled 
phenomenon changes) must be a linear Transfer Function. 
 
To define a new sensor: 

1.  Connect TriLink to the PC 

2.  Select Define new sensor from the Logger menu to open the 
Define new sensor dialog box: 

 

Figure 28: Define New Sensor dialog box 

3.  Click Add New Sensor. 

4.  Type in a sensor name and a sensor unit. 
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5.  Type in two calibration values (two real values and the 
corresponding output voltages of the sensor). 

6. Click OK. 

3.6.8. Communication Setup 

TriLink communicates with the DaqLab software via a serial communication port. 
Some users may find it difficult to select the correct port, in which case DaqLab can 
perform an automatic port selection, and can also report on the status of all available 
ports. 
 
Automatic COM Port recognition 
The standard PC has 4 communication ports, COM-1 to COM-4. One of these ports 
is usually available for external communication. It is not necessary to know which 
port is available, since DaqLab can find it for you.  
Connect the communication cable from TriLink to one of the PC COM Port 
connectors.  
Turn on TriLink and run the DaqLab software. DaqLab will automatically attempt to 
communicate with the data logger. If communication is achieved, the selected port 
becomes designated as TriLink’s communication port  
If communication fails: 

1.  Select Comm Setup from the Logger menu. DaqLab will display a 
dialog box reporting what COM Ports are already in use, and which 
port is recommended for use with TriLink. 

2. Click Try to connect and DaqLab will try to communicate with 
TriLink. If communication is achieved, DaqLab will designate the 
selected port as TriLink’s communication port 

You can override the DaqLab recommendation and choose the COM Port yourself by 
clicking the check box button to the left of the desired port, and clicking Try to 
connect. 

3.  You can click Work offline if you wish to work without TriLink. While 
working offline, you can still open saved files to view and analyze 
them. 
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3.7.  Analyzing the Data 

3.7.1. Reading Data Point Coordinates 

Position the cursor (refer to page Error! Bookmark not defined.) on a point to display 
its coordinates on the information bar at the bottom of the graph window. 
If more than one curve is displayed, and you want to read the Y coordinates of all of 
the curves simultaneously, bring up digital meters (refer to page Error! Bookmark not 
defined.) for each of the curves. When you position a cursor on one curve, the meters 
will show the corresponding Y-coordinates for the other curves. 

3.7.2. Reading the Difference between two Coordinate Values 

Position one cursor on the first point and a second cursor on the second point to 
display the difference between the two coordinate values on the information bar at 
the bottom of the graph window. 

3.7.3. Working with the Analysis Tools 

The analysis tools can only be applied to data sets that are displayed in the graph 
window. 

1.  Use the cursors (refer to page Error! Bookmark not defined.) to 
select the graph and the data range to which you want to apply the 
analysis.  

2.  Select the analysis function you wish to use. 

The analysis function will be added onto the graph, with the exception of the 
smoothing (averaging) function, which will replace the original data set. 

3.7.4. Smoothing 

The smoothing tool is very useful in reducing random noises, especially if you want to 
apply any analysis functions to the data. The smoothing process replaces every data 
point with the average of its neighboring points. 

1.  Use the cursor to select the function on the graph that you want to 
smooth. 

2.  Click More smoothing  on the graph toolbar. 

3.  You can repeat the procedure to further smooth the data. 

4.  Click Less smoothing  to reduce the amount of smoothing. 



 
 

 Chapter 3: Working with a Desktop Computer and DaqLab 65 

3.7.5. Statistics 

Use the statistics tool to display statistics of a selected data set or a range of data. 
The statistics include: 

Average – The average of all the numbers in the range 

StDev. – The standard deviation 

Minimum – The smallest value in the range 

Maximum – The largest value in the range 

Sum – Adds all the numbers in the range 

Area – The area between the graph and the x-axis in the range 

Samples – The number of data points in the range 

Rate – The recording rate 

 
To display statistics: 

1.  Use the cursors to select the graph and the data range to which you 
want to apply the statistics 

2.  Click Analysis on the main menu, and then click Statistics. 

3.  DaqLab will open a statistics window in which it will display the 
results. 

3.7.6. Most Common Analysis Functions 

1. Linear Fit 

Click Linear Fit  on the main toolbar to draw a line of linear least square fit  
and to display the line’s equation y = ax + b 
Note: If you want the automatic curve fit equation to start at t = 0, apply the Crop tool 
before applying the linear fit (refer to page 73). 

2. Derivative 

Click Derivative  on the main toolbar to construct a graph in which each point is 
the slope of the 3 consecutive points on the source graph. 

3. Integral 

Choose Integral from the Analysis menu to construct a graph in which each point is 
the integral of all the preceding points on the source graph. 
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3.7.7. The Analysis Wizard 

1. Using the Analysis Wizard 

The Analysis Wizard will guide you through the various analysis functions available in 
the DaqLab program. The analysis functions are grouped into three main categories: 
Curve fit (regression), averaging, and mathematical and trigonometric functions. 
To apply an analysis function to a data set: 

1. Use the cursors to select the graph or data range to which you 
would like to apply the analysis. 

2. Click Analysis Wizard  on the main toolbar. 

3. Click a Category tab: 

 Curve fit 
 Averaging 
 Functions 

2. Curve Fit 

 

Figure 29: Analysis wizard – Curve fit 

1. Select a fit Type by clicking its icon (if you choose polynomial fit, 
select the order you want). 

2. If you use the cursor to select a data set, it will be highlighted in the 
Based on data set list, but you have the option of selecting a 
different data set. 

3. Type a name in the Name box (optional - the default name includes 
both the function and the data set names). 
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4. Click the Show equation on graph check box to display the line’s 
equation on the information bar. 

5. Click the Show R2 on graph check box to display the correlation 
coefficient on the information bar. 

6. Click OK. 

Note: If you want the automatic curve fit equation to start at t = 0, apply the Crop tool 
before any type of curve fitting (refer to page 73). 

3. Averaging 

 

Figure 30: Analysis wizard – averaging 

1. If you use the cursor to select a data set, it will be highlighted in the 
Based on data set list, but you have the option of selecting a 
different data set. 

2. Select an averaging option (if you choose custom averaging, 
choose the number of averaging points in the Points box). 

3. Enter a name in the Name text box (optional - the default name 
includes both the function and the data set names). 

4. Select an Open option. 

5. Click OK. 
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4. Functions 

 

Figure 31: Analysis wizard – functions 

1. Select a function from the Functions list. DaqLab displays the 
function’s formula at the bottom of the dialog. 

2. If you use the cursor to select a data set, it will be highlighted in the 
G1 drop-down menu, but you have the option of selecting a 
different data set. 

3. If the analysis function involves two data sets, select the second 
data set from the G2 drop-down menu. 

4. Enter a constant in each of the C1 and C2 boxes (optional). 

5. Enter a name in the Name text box (optional – the default name 
includes both the function’s formula and the data set name). 

6. Enter a unit (optional). 

7. Select an Open option. 

8. Click OK. 

3.7.8. Available Analysis Tools 

This section includes a brief description of each of DaqLab’s analysis functions. 

1. Curve Fit 

Linear baxy +=  

 Draws a line of linear least square fit 



 
 

 Chapter 3: Working with a Desktop Computer and DaqLab 69 

 

Polynomial n
nn axaxay +++= − L1

10  

 Draws a line of polynomial least square fit (you must select an order 
between 1 and 6.) 

 

Power 
nx

ay =
 

 Draws a line of power least square fit 

 

Exponential bxaey =  

 Draws a line of exponential least square fit 

 
DaqLab displays the curve fit equation and the correlation coefficient (R2) on the 
information bar below the graph. 

2. Averaging 

The average function replaces every point with the average of n neighboring points 
from both sides of the point. 
Low averaging: 5=n , Medium averaging: 11=n , High averaging: 41=n  

3. Functions 

In the formulas below, G1 and G2 represent selected data sets, and C1 and C2 are 
constants that you can enter. The constant’s default value is 1. 

Absolute 121 GCCy =  

 Draws a line of the absolute values of a data set 

 

Add 2211 GCGCy +=  

 Draws a line of the addition of two data sets 

 

Arccosine )arccos( 121 GCCy =  

 
Draws a line of the arccosine values of a data set (in radians). 
Arccosine is the angle whose cosine is 12GC . The argument 12GC  
must be between –1 and 1. 

 

Arcsine )arcsin( 121 GCCy =  

 
Draws a line of the arcsine values of a data set in radians. Arcsine is 
the angle whose sine is 12GC . The argument 12GC  must be between 
–1 and 1. 
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Average C1·{average of C2 points around G1} 

 Replaces every point with the averaging of C2 neighboring points 

 

Cosine )cos( 121 GCCy =  

 Draws a line of the cosine values of a data set. The argument 12GC  
must be expressed in radians. 

 

 

Delta Y 
)0(11 =−= tGGy  

 
Draws a line of the difference between the Y-coordinate of every 
point and Y-coordinate of the first point. Use this function to move the 
data set along the Y-axis so that the point will intersect the Y- axis at 
the origin. 

 

Derivative 
ratesampling

t
t
yyy nn

n
1,

2
11 =Δ

Δ
−

= −+  

 
Draws a line of the slopes of every three consecutive points of a data 
set. For high recording rates and small Δt, this line may be very noisy, 
which is why smoothing the data set is recommended before applying 
the derivative function. 

 

Divide 
22

11
GC

GCy =  

 Draws a line of the division of two data sets 

 

Envelope 
(lower) Lower envelope of G1 with tolerance of C1 points 

 
Draws a line that connects the minimum values of a data set. The 
tolerance defines the minimum distance (in sampling points) between 
two minima, so that the envelope function is able to ignore random 
noises. 

 

Envelope 
(upper) Upper envelope of G1 with tolerance of C1 points 

 
Draws a line that connects the maximum values of a data set. The 
tolerance defines the minimum distance (in sampling points) between 
two maxima, so that the envelope function will be able to ignore 
random noises. 
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Exp. 12
1

GCeCy =  

 Draws a line of e raised to the power of a data set 

 

Fourier 
transform Discrete Fourier transform of G1. 

 Draws a line of the amplitudes of the harmonics of Fourier transform 
vs. frequency 

 

Frequency The frequency of G1 (minimum of C1 points in one cycle). 

 Draws a line of the frequency of a periodic data set vs. time. The 
constant C1 defines the minimum data points in one cycle. 

 

Integral tGCCy Δ∑+= 121  

 Draws a line in which each point is the discrete integral of all the 
preceding points in a data set 

 

Linear 121 GCCy +=  

 Draws a line of a linear displacement of a data set. This function is 
useful when you want to change the point of origin of a data set. 

 

Ln )ln( 121 GCCy =  

 Draws a line of the natural logarithm of a data set. The argument 
12GC  must be positive. 

 

Log )(log 12101 GCCy =  

 Draws a line of the logarithm of a data set to base 10. The argument 
12GC  must be positive. 

 

Multiply 2211 GCGCy ⋅=  

 Draws a line of the multiplication of two data sets 

 

Reciprocal 
(1/X) 

1

1

G
Cy =  

 Draws a line of the reciprocal values of a data set 
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Sine )sin( 121 GCCy =  

 Draws a line of the sine values of a data set. The argument 12GC  
must be expressed in radians. 

 

Square (X2) 2
121 )( GCCy =  

 Draws a line of the squares of a data set. 

 

Square root 121 GCCy =  

 Draws a line of the square root values of a data set. The argument 
12GC  must be greater than or equal to zero. 

 

Subtract 2211 GCGCy −=  

 Draws a line the subtraction of two data sets. 

 

Tan )tan( 121 GCCy =  

 Draws a line of the tangent values of a data set. The argument 12GC  
must be expressed in radians. 

 
Position the cursor (see page 89) on a point to display its coordinates on the 
information bar at the bottom of the graph window. 
If more than one curve is displayed, and you want to read the Y- coordinates of all of 
the curves simultaneously, bring up digital meters (see page 95) for each of the 
curves. When you position a cursor on one curve, the meters will show the 
corresponding Y-coordinates for the other curves. 

3.7.9. Reading the Difference between two Coordinate Values 

Position one cursor on the first point and a second cursor on the second point to 
display the difference between the two coordinate values on the information bar at 
the bottom of the graph window. 
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3.8.  Special Tools 

3.8.1. Crop Tool 

The Crop tool enables you to trim the edges of a data set. Use it to remove unwanted 
data. 
The time scale of the trimmed data is shifted so that it will start at 0=t . 
If you want the automatic curve fit equation to start at 0=t , apply the Crop tool 
before any type of curve fitting 
After applying the Crop tool, the trimmed data set replaces the original set on the 
graph display and a new icon is added to the Data Map under cropped data. 

1. To trim all data up to a point 

1. Position a cursor (refer to page Error! Bookmark not defined.) on 
the data point. 

2. Click on the Graph menu, and then click Crop. 

2. To trim all data outside a selected range 

1. Use the cursors to select the range you want to keep. 

2. Click on the Graph menu, and then click Crop.
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3.9.  Toolbar Buttons 

3.9.1. Main (Upper) Toolbar 

 
New Start new project 

 
Open Open saved project 

 
Save Save project 

 
Print Select print options 

 
Run Start a data recording session. Click on the down-arrow 

to select recording mode. 

 
Stop Stop recording 

 Download Download the data from the most recent recording 
session 

 Setup Open the Setup dialog 

 
Meter Setup Open the Meter setup dialog 

 
Data Map Display the Data Map 

 
Graph Display the graph window 

 
Table Display the table window 

 
Analysis Open the Analysis wizard 

 
Linear Fit Draw a line of linear fit of the selected data set 

 
Derivative Draw a line of the derivative of the selected curve 
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3.9.2. Graph Toolbar 

 Zoom In Zoom in around a selected point or in to a selected 
range 

 Zoom Out Reverse the most recent zoom operation 

 Autoscale Display all the data 

 Zoom to Selection Zoom in to a selected area 

 Pan Pan in all directions while in zoom mode 

 More Smoothing Smooth (average) the selected curve 

 Less Smoothing Reverse the most recent smoothing operation 

 1st Cursor Display or remove the first cursor 

 2nd Cursor Display or remove the second cursor 

 Split Graph Switch to a split graph display 

 Edit Graph Select the data to display on the axes 

 Graph Properties Graph formatting, scaling and units selection 

 Add to Project Add the displayed graph to the project 

 Export to Excel Export the displayed graph to Excel 
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Chapter 4  
Troubleshooting Guide 

Symptom Cause of problem 
  
I pressed the ON key on TriLink 
and it did not turn on. 

• After pressing the ON key wait 3 
seconds for TriLink to wake up 

• Try charging the battery, it may be 
weak. 

• You are using unsuitable AC/DC 
adaptor. 

  
TriLink displays BT_fail during 
startup 

• The USB cable is connected 

  
Bluetooth connections is denied 
(even after pairing) 

• The USB cable is connected 

  
  
I started a new logging and the 
data logger stopped immediately 
afterwards. 

• First check if the sampling rate was so 
fast that the experiment began and 
ended in less than a second. If this is 
not the reason, recharge the 2.4V 
battery and try again. TriLink monitors 
the battery power during the logging. If 
the battery voltage is not sufficient, the 
logging is stopped automatically. 

  
The recorded data is noisy • With voltage or current sensors, use 

short connections between the circuit 
being tested and the sensor. In some 
cases it is advisable to connect the (-) of 
the current sensor to the ground 
terminal  

• Avoid working near strong 
electromagnetic fields. (e.g. engines, 
fluorescent lights )  

 
  
TriLink’s memory is empty – 
there is nothing stored 

• The internal 3V disk battery is dead. 

TriLink battery running low, 
unable to continue 

• Charge TriLink completely (12 hours) 
• Use TriLink while connected to a wall 

outlet 
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TriLink has stopped responding • TriLink has disconnected from the 
computer but continues to run 
independently as a data logger. 

• Press the Run/Stop button on TriLink. 
(LCD screen on TriLink shows changing 
data values) 

• Reconnect TriLink to the computer 
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Chapter 5  
Specifications 

Inputs Up to 4 simultaneous analog inputs 
 External sensors Temperature -50 °C to 150 °C 

Current 0-20 mA, Voltage 0-5 V, Pulse 
Counter, combined Relative Humidity 
and Temperature Sensor 

Outputs Bluetooth 1.2 wireless communication link (Toshiba and 
Broadcom/Widcom chipsets) 

 USB PC host interface at 1.1 Mbps 
Sampling Resolution: 12-bit (4096 Levels) 
 Capacity: Up to 256,000 samples 
 Analog sampling rate: 1 sample/hr to 20,800 sample/sec 
 Digital sampling rate: >200 kHz 
Features User interface: Alfa Numeric LCD, 2 lines by 16 characters each 
 Stand alone operation without connection to a PC 
 Automatic or manual sensor identification 
 Saving and loading of last setup 
  Triggering 
 Built-in battery charger for charging the 2.4 V internal battery 
 Event recording 
 User-defined sensors 
Power supply Voltage: Internal rechargeable 2.4 V NiMH battery 
  External 6 V DC input 
Software DaqLab for Windows 98/2000/XP and Vista, Pocket PC 
Operating temp. range 0 °C to 50 °C  
Dimensions 93 x 100 x 27mm  
Weight 160 gr  
Standard compliance CE, FCC  
   
   
Ordering information Part No. Description 
TriLink basic pack TRL1 TriLink data logger, one USB 

communication cable, DaqLab software 
for PC and PocketPC, carrying case, 
AC/DC adaptor 

Accessories DT 231 Mini USB Communication Cable 
 DT241 Temperature sensor 
 DT234 Current sensor 
 DT228 Voltage sensor 
 DT041 Humidity and Temperature sensor 
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